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[bookmark: _Toc82496933][bookmark: _Toc77385842][bookmark: _Toc516578720][bookmark: _Toc516578424][bookmark: _Toc516577352][bookmark: _Toc513735223][bookmark: _Toc256601679]Objectives
1. Be able to start a new GEOPAK job with the Start Job dialog.
1. Be able to add a new user to an existing GEOPAK job with the Start Job dialog.
1. Learn how to set up a project using Project Manager.
1. Learn how to utilize Project Manager as a workflow guide.
1. Learn how to access GEOPAK dialogs from the Project Manager.

[bookmark: Definition][bookmark: _Toc82496934][bookmark: _Toc77385843][bookmark: _Toc516578721][bookmark: _Toc516578425][bookmark: _Toc516577353][bookmark: _Toc513735224][bookmark: _Toc256601680]Definition – Start Job
Start Job is a tool that will set up a GEOPAK job for a user, or add users to an existing job.  Start Job will create the job directories, and copy default MicroStation files to the directories.  Start Job will also append the job number to the end of the copied Microstation files if that option is activated.  Once a job has been created, Start Job will add a user to the job.
[bookmark: _Toc82496935][bookmark: _Toc77385844][bookmark: _Toc516578722][bookmark: _Toc516578426][bookmark: _Toc516577354][bookmark: _Toc513735225][bookmark: _Toc256601681]Accessing
Start Job can be accessed from the following Microstation menu:

 Design>>ProjectWise Start GEOPAK Job/Add User.
[bookmark: StartJobDialog][bookmark: _Toc82496936][bookmark: _Toc77385845][bookmark: _Toc516578723][bookmark: _Toc516578427][bookmark: _Toc516577355][bookmark: _Toc513735226][bookmark: _Toc256601682][image: ]Start Job Dialog
Once the user has accessed the Start Job dialog box, shown right, the tool can be used to either create a new job or add users to an existing job.   

If the user is creating a new job, do not check the Add Users to Existing Job toggle.  The user then types in the appropriate number in the Job Number field. Note that the Browse button for selecting a job number is ghosted out.  This is because the job doesn’t exist yet.  The user needs to specify the path in which the job will be placed.  The Browse button can be selected to navigate through the path.  The next step is to choose the userids of the people that will be working on the job. The user can select one or multiple user ID’s. 

In addition, for a new job, select the Units and the Sheet types that will be used for the job.  This will create a directory for each Sheet type selected to place the sheets into as they are created.

If a job already exists, and the users are being added to the job, check the Add Users to Existing Job toggle.  Note that the Path, Units, and Sheets options will ghost out, and the Job Number Browse option will become available.  Because the job already exists, the user can browse through the job directory to select the Job Number.
Once all fields have been filled in, select the OK button.  The job directories will be set up as shown below.

PW:\ District #
Design\
County\
Job Number\
Data\
dtm.dgn
pattern_shape.dgn
plan.dgn
profile.dgn
topo.dgn
xs.dgn
MoDOT.lpf
MoDOT.ols

Plan_Sheets\
100
20
Project\
job number.prj (Project Name / Number)
projdbs\
job number.rpt (User Preferences)
userid2\
job number.003 (Proposed Cross Sections)
job number.004 (Earthwork)
job number.005 (Cross Section Sheets)
job number.006 (Survey)
job number.008 (Define-Working Alignment)
job number.009 (Existing Ground Profile)
job number.00a (Vertical Alignment)
job number.00c (Limits of Construction)
job number.00d (Existing Ground-DTM)
job number.00e (Existing Ground Cross-Sections)
job number.00f (Reports and XS Quantities)
job number.010 (Model)
job number.011 (Draw Pattern)
job number.012 (Calculate Superelevation)
job number.014 (Plan / Profile Sheets) 
job number.ifo (User Id)



The Data directory contains any project data.  This is the directory that contains the Microstation drawings, and any input or output files.  The Sheet directories contain the plan and profile sheets, cross section sheets, and any other sheets for the project.  The Project directory contains the GEOPAK project manager file (.PRJ), and the userid directories.  The Userid directories contain the user runs for the job.

The GEOPAK coordinate geometry database (.GPK), because many users can access it at the same time, is store outside of ProjectWise in the following location:
 
T:\
De-proj\
County\
Job Number\
        Data\
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[bookmark: Definitions][bookmark: _Toc256601683]Definition – Project Manager
Project Manager is a GEOPAK tool that associates a project with its respective gpk job number, users, working directories and project files.  Project Manager provides the user with an easy workflow system that keeps records of processes run throughout the design of a project.
[bookmark: Accessing][bookmark: _Toc256601684][image: ]Accessing
To access Project Manager, select Applications >> GEOPAK Road >> Project Manager 





[image: ]or select the Project Manager icon.	


[image: ]The following dialog appears: 
 

[bookmark: ProjectManagerDialog][bookmark: _Toc256601685]
Project Manager Dialog
[bookmark: _Toc256601686]General Description
The current directory is displayed at the top of the dialog box.  This can be modified by traversing to a different directory in the Directories list box.  Project files (.prj) are displayed in the Projects list box.  The project files should be located in the 
pw:\District ??\Design\county\jobnumber\project directory.

The remainder of the Project Manager dialog box displays information after a project has been selected from the Projects list box.  At the bottom of the dialog are the OK and Cancel buttons.  If the user wishes to exit Project Manager, the Cancel button should be selected.  To continue in the Project Manager process, the OK button should be selected.
[bookmark: ProjectManagerMenuBar][bookmark: _Toc256601687]Project Manager Menu Bar
There are three pull down choices on the Menu Bar: Projects, Directory, and Admin.  Each of these choices has options contained in the pull down.

[bookmark: ProjectTools][bookmark: _Toc256601688]Project Tools
There are four choices under the Projects pull down: New, Edit, Delete, and Exit as shown below.
[image: ]
As can be seen from this dialog box, the Windows motif also keeps track of the last few processes that have been executed.  These may be recalled as needed by selecting the desired process. 

The New menu option is used to create a new project.  The .prj file will be stored in the directory shown in the Directory path at the top of the Project Manager dialog box.  When the New menu option is selected, the following Create New Project dialog appears.
[image: ]
The Project Name can be any number of alphanumeric characters.  For MoDOT projects, the Project Name needs to be the same as the job number. (i.e. j1p0999.prj)  The Working Directory specifies the location of the project data files.  The Working Directory may be keyed in or the Select button may be chosen and the appropriate directory selected.  For MoDOT, the Working Directory should be set to pw:\District ??\Design\county\jobnumber\data directory.

The next field is for typing in the cogo job number, or the Select button may be chosen and the appropriate cogo job number selected.

[bookmark: _GoBack]Shown below is a sample project that includes a project description, which may be keyed in at the bottom of the Create New Project dialog box. 

For MoDOT users, the (.PRJ) file and the (.GPK) file are automatically created during the Start Job routine.

The Edit menu option is used to change any settings associated with the currently selected project.  When chosen, the Project Info Edit dialog box appears.

[image: ][image: ]

To review or change any of the preferences, select the Preferences button, and the following Project Preferences dialog appears.

[image: ]

The user may set the particular parameters for each project as well as the Working Directory.  By setting these parameters for the project, the user does not need to re-set these parameters as they change projects.  The preferences set with that project are recalled when the project is recalled.  After all of the information is entered, the OK button is selected, or if the user wishes to abort, the Cancel button may be selected.  For more information on the User Preferences dialog, see section 1.4 in the Chapter 1.

The Delete menu option is used to delete any project that has been stored.  The user highlights the project in the Projects and selects Delete.

The Exit menu option closes the Project Manager and writes the settings to a resource file.
[bookmark: DirectoryTools][bookmark: _Toc256601689][image: ]Directory Tools
There are two options under the Directory pull down, Create New Directory and Current Working Directory as shown.

The Create New Directory option will create a new directory on the disk.  If the Current Working Directory option is chosen, the directory path in Project Manager is changed to that directory.
[bookmark: AdministrationTools][bookmark: _Toc256601690]
Administration Tools
[image: ] The Administration menu option is used to set a password on a project.  It is recommended that a password not be used since the project will need to be accessed by more than one user.

[bookmark: ProjectUsersDialog][bookmark: _Toc256601691][image: ]Project Users Dialog
Once a project is highlighted and OK is selected, the Project Users dialog appears. 

This dialog has three sections: Project Users, User Info, and Description.  The Project Users list displays a list of users that have been created to work with any project that resides in the current projects home directory.  The names shown in Project Users will be the userid’s of the people working on that project as specified in the Start Job dialog.  Within the User Info group box, the Full Name field further identifies the user, and displays the full name of the user that is currently selected.  The OP Code field displays the GEOPAK Operator Code of the currently selected user.  The GEOPAK Operator Code is used for all coordinate geometry operations during this session.  The Operator Code, along with the Job Number, will be utilized whenever an input or output file is created by the software.  The Operator Code will be the user’s initial.  The Description field displays the description of the currently selected user.

[image: ]Four tools are supported on the Project Users pull down as depicted in the exploded view below.  
[bookmark: New][bookmark: _Toc256601692]New
The New pull down menu option creates new users.  This option is not to be used at MoDOT.  To create a new user for a project, use Start Job/Add User under the MoDOT menu.  This is the only way the user will have the default MoDOT runs.
[bookmark: Edit][bookmark: _Toc256601693]
Edit
The Edit pull down menu option allows the user to change any of the parameters of the currently selected user.  (Note: The User cannot be changed.  This will change the user information for the current project only.)
[bookmark: Delete][bookmark: _Toc256601694]Delete
The Delete pull down menu option allows the user to delete the currently selected user.  
[bookmark: Password][bookmark: _Toc256601695]Password
The Password tool creates or modifies a password for the selected user.  If the selected user already has a password, the user will be prompted to enter the current password before continuing.
[bookmark: Exit][bookmark: _Toc256601696]Exit
The Exit option closes the User dialog and returns back to the Project Manager dialog.
[bookmark: RoadProjectDialog][bookmark: _Toc256601697]Road Project Dialog
After a minimum of one user has been defined, selecting the OK button on the lower left corner of the Project Users dialog or double clicking on a Project User will open the Applications dialog as depicted below.  

[image: ]
[bookmark: GeneralDescription][bookmark: _Toc256601698]
General Description
The top of the dialog displays the Working Directory, Working Alignment (if defined), User and GEOPAK Job Number.  In addition, a toggle for Working Alignment Influence Runs is also supported.  The bottom portion of the dialog box displays the various processes supported during the design process.  The small square in the upper right corner (to the right of the Job Number) will condense the dialog as depicted in the graphic below.  
[image: ] 

In addition, the user can sink the dialog by data pointing on the Bentley B located on the upper left corner of the banner and selecting the sink option.


[bookmark: RoadProjectDialogMenuBar][bookmark: _Toc256601699] Road Project Dialog Menu Bar
[image: ]There are three pull down menu bar options: File, Remember, and Options.  When the File option is selected, the choices are Close and Exit.

If the Close option is selected, the user is returned to the Applications dialog.  If Exit is selected, the user is exited from Project Manager.
 
[image: ] When the Remember option is selected, the user can instruct the software to remember the Project, or User in subsequent sessions.  For example, if both toggles are activated, and the Project Manager is completely closed, the invocation of the Project Manager immediately invokes the Road Project dialog (flow chart) and utilizes the project name, username, etc., which were active when the Remember toggles were selected.  If only the Project toggle is activated, the user is returned to the Project Users dialog in subsequent sessions.  This option is particularly useful when numerous users are working on one project.
[image: ]The Options menu allows the user to toggle on the Auto Sink option.  When toggled on, this option will sink (move behind the open drawing views) the Road Project dialog when a tool is chosen from the Road Project.  When a tool is closed, the Road Road Project dialog will become the active dialog. 
[bookmark: WorkingAlignment][bookmark: _Toc256601700]Working Alignment
The concept of a working alignment enables the designer to organize a project and to access project information without continually typing the required information.  On a simple project, only one working alignment may be needed.  However, on a more complicated project, an unlimited number of working alignments may be defined.  The designer can easily change from one working alignment to another by highlighting the desired alignment listed in the Select dialog.  Three tools relating to working alignments are located at the top of the Road Project dialog:

[image: ]

·  Select Button
· Define Button
· Working Alignment Influence Runs (toggle on left side of dialog)

[bookmark: SelectOption][bookmark: _Toc256601701]Select Option
[image: ]When the Select button is pressed, the Select Working Alignment dialog appears as depicted to the right.  If no working alignments have been defined, MoDOT appears in the Run List box.  If working alignments have been defined, they are listed with the last run time.  The description of the working alignment can be seen in the bottom of the dialog when each Name is highlighted.  To select a previously defined working alignment, highlight the run from the list, then press the OK button at the bottom of the dialog.  Double clicking on the Name also selects a previous working alignment for subsequent processing.  Pressing the Cancel button will close the Select Working Alignment dialog without any working alignment change.  Several file option are supported as depicted in the exploded view on the next page.  These include New, Copy, Modify, and Delete. 
· 
Run>>New – allows the user to create a new working alignment.  (Do not use this option as it will not copy the default MoDOT settings for the working alignment.  Instead, use Run>>Copy>>Run to copy the MoDOT run.)
[image: ]
· Run>>Copy – allows the user to copy and a new run from an existing Project, User or Run.

· Run>>Modify – allows the user to change the name or description of the existing working alignment. 

· Run>>Delete – allows the user to delete an existing working alignment.

[bookmark: DefineOption][bookmark: _Toc256601702][image: ]Define Option
Once a Working Alignment has been selected, pressing the Define button invokes the dialog depicted to the right.  The information that can be associated with a working alignment is listed in the left portion of the dialog box.  As each option is chosen, the right side of the dialog box will change to reflect the information needed as can be seen in the dialog box to the right after Profile View was selected. 
[image: ]
All information entered in these fields can be used in subsequent processes runs from the Road Project Manager.  In the beginning of a project, much of this information will not be known. As the user goes through the design process, it can be added to the working alignment definitions.  


[image: ]For example, as soon as the chain has been stored in COGO, the user can enter that information in the Plan View fields as depicted to the right.  For a more complete explanation of each option shown, please see the GEOPAK Manual.



[bookmark: PortViewer][bookmark: _Toc256601703]Port Viewer
The Port Viewer is a tool that enables the user to view all three major aspects of a road design simultaneously even though they are located in different files.  The three views include:
· Plan
· Profile
· [image: ]Cross Section


[bookmark: _Toc256601704]Accessing
Prior to starting the Port Viewer the working alignment must be set up to include the plan view drawing file, centerline chain, profile view file, profile name and location, and cross-section view file.

To access the Port Viewer, choose the Port Viewer button from the Road Project dialog.
[bookmark: _Toc256601705]Dialog
The Port Viewer dialog box allows the user to manipulate the views several different ways.

[bookmark: _Toc256601706]Station, Offset, and Elevation Controls
[image: ]The user is able to key-in the Station they want to view.  The cross hairs in the plan and profile move to the keyed-in station, and the section view displays the cross-section nearest that station.

The navigation buttons allow the user to navigate station by station (< or >), or to the beginning (<<) or ending (>>) station.

The Offset option controls the location of the circle in the plan view and the vertical cross hair in the cross-section view.

The Elevation option controls the location of the horizontal cross hairs in the profile and cross-section views.

[image: ]If the Portview TIN is defined in the Working Alignment definition, the DTM view can be substituted for the cross-section view.  The DTM view cuts a section at the location of the cross hairs in the plan view.
[bookmark: _Toc256601707]Active View Control
[image: ]The Active View chooses the view to be used as the current file.  Any MicroStation drawing commands are executed in that file.  For instance, if you want to draw something in the cross sections, switch the Active View to XS View.

Selecting the Set button allows the user to move the cursor to a view and move the cross hairs in that view.  As the user moves the cursor along the view, the other two views are updated according to the placement of the cursor in the current view.

The DP button allows the user to issue a data point for a MicroStation command.  For example, if you wanted to draw a line at the given station and offset listed in the Port Viewer dialog, select the line tool, and press the DP button.  This begins a line at the given station and offset.
[bookmark: _Toc256601708]
Menus
The View menu at the top of the dialog box allows the user to fit one or all of the views, or to select the Active View.  

[image: ]	 [image: ]

The Options menu has one item, Display.  The Display Options control which cross hairs to display (Plan, Profile, & XS), whether to center the Plan and Profile views, the symbology and offsets of the DTM section view (XS section of dialog), whether to Show Stations only at XS cell, the cross hair symbology (Marker Display), and how close the curser needs to be to the cross hairs to gain dynamic control (Dynamic-to-Cursor Sensitivity).

[image: ]

[image: ]







[bookmark: RoadProjectProcess][bookmark: _Toc256601709]Road Project Process
The Road Project dialog is depicted below.  The advantage of utilizing the Road Project dialog rather than selecting functions directly from the Road menu is that pertinent information stored within the Road Project is automatically displayed within the invoked dialog.  Therefore, job numbers, chain names, stationing, file names, and data associated with the project do not have to be typed in each time a dialog is utilized.  However, if the user chooses to change the fields, they have that option.

[image: ]

Many of the Road Project processes function identically to their corresponding dialog’s invocation from the Road menu.  However, some of the procedures will invoke the Select Run dialog prior to invoking the actual dialog.  The Select Run dialog allows the user to set up different options to use in alternative design choices.

Each of the Road Project dialog processes will be covered individually in the separate remaining chapters.
[bookmark: SelectRunOption][bookmark: _Toc256601710]Select Run Option
When certain procedures are selected from the Road Project dialog, the Select Run dialog will be invoked.  The Select Run dialog allows the user to save the settings for each procedure in a Run that can then be recalled whenever the user needs to execute that procedure.  With the individual runs, a user can keep a history of the project, and can access the various procedures with the settings that were previously used.  This way a user can repeat various procedures with the same settings previously used. 
[image: ]
When the Select Run dialog is invoked, MoDOT appears in the Run List box.  (Some Select Run boxes will display default run names such as English, Metric, I_XS_10, etc.)  If Runs have been defined, they are listed with the last run time.  The description of the Runs can be seen in the bottom of the dialog when each Name is highlighted.  To select a previously defined Run, highlight the run from the list, and then press the OK button at the bottom of the dialog.  Double clicking on the Name also selects a previous Run for subsequent processing.  Pressing the Cancel button will close the Select Run dialog without any run settings change.  Several file option are supported as depicted in the exploded view below.  These include New, Copy, Rename, and Delete. 

· [image: ]Run>>New – allows the user to create a new run.  (Do not use this option as it will not copy the default MoDOT settings for the procedure selected.  Instead, use Run>>Copy>>Run to copy the MoDOT run.)

· Run>>Copy – allows the user to copy and existing Project, User or Run.

· Run>>Modify – allows the user to change the name of the existing Run. 

· Run>>Delete – allows the user to delete an existing Run.

[bookmark: Example3_1][bookmark: _Toc256601711]
Exercise 2-1  
1. Open any MicroStation file 

2. Create the following job with the Start Job dialog.  

[image: ]



3. Review the directory structure and the files created in the directory.

4. Use the Project Manager dialog to review the newly created project:  

Start Project Manager  

Navigate to the following directory:

pwname:\\MoDOT\Documents\District CADD\Design\Miller##\J5P0444\project  

The J5P0444.prj file should be listed as shown next page  








[image: ]





















5. Choose Projects>>Edit.  It should read as follows:  

[image: ]

Project name:  J5P0444  

Working Directory:     pw:\District CADD\Design\Miller##\J5P0444\data\

Job Number: 444  


6. Select the Preferences button to review user preferences set for the project, they should be set as shown below.  

       Working Directory:     pw:\District CADD\Design\Miller##\J5P0444\data\


[image: ]



7. Select the COGO Preferences to review.  The Job (GPK) Directory should be set as shown below.  The COGO Input & Output File Directories can be left blank.

      Job (GPK) Directory:     t:\de-proj\Miller##\J5P0444\data\

[image: ]




8. Add user5 as a new user to the newly created project J5P0444.


[image: ]
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